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MAGNET V3.3.1 Release Notes - Introduction

Please take time to read these Release Notes. They contain information about the following:
Improvements 
Bug fixes 

NOTE:
It is always recommended, before upgrading your field software, users backup their original job; and following any update
to your field software, users perform in-the-field checks to ensure data integrity
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MAGNET Field 3.3.1

General

The Following update applies to all versions of the MAGNET Field Solution V3.3.1:

 Addressed and issue with License validation and auto-reactivation.  After updating to MAGNET 3.3, the
auto-reactivation did not work.

 Addressed an issue when using the Transformation to France Lambert 93 with RAF09 geoid.  The
resulting point elevations were incorrect.

 Addressed an issue with Resection and Setup instrument for 3DMC.  Point coordinates from staked points
were shifted. 

 Rename Tracking Measurement to Advanced Tracking to match the Instrument onboard settings.
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MAGNET Office 3.3.1

General

The Following update applies to all versions of the MAGNET Office and Tools V3.3.1:

 Addressed an issue when using the Transformation to France Lambert 93 with RAF09 geoid.  The
resulting point elevations are incorrect
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MAGNET Field 3.3

General

The Following update applies to all versions of the MAGNET Field Solution V3.3

New Features 
 Added support for the Macao Grid projection and Macao datum

 Added support for the New Zealand (NZ2009) geoid

 Added support for the New Zealand vertic al datum (NZVD2009)

Improvements 
 Updated the list of US Geoids to inc lude 2012B in the name

o US Geoid 1999-2012B

 Updated the “APA-SIMA”  raw data export to export the ‘code’ as NOTE

 Updated the UI to separate the X and check mark to avoid accidental closing of dialogs

 MAGNET Field Onboard: Changed the default setting of ‘Auto Target’ to be on by default

 Added support for US Inches when importing points.  

 MAGNET Field Onboard:  added support for File Explorer to allow browsing to external USB drives

Addressed Issues 
 Addressed an issue when upgrading jobs with localizations.  Elevations are now displayed c orrectly

 File Explorer removed from MAGNET Field Onboard

 Addressed an issue when exporting raw data export in APA-SIMA format.  The offset measurement was
not exported correctly 

 Addressed an issue when opening jobs with the Finnish KKJ projection  

MAGNET Office 3.3
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General

Magnet Office 
The following improvements have been made to the Magnet Office Site, Topo and Layout modules. Unless noted, the
improvements and/or revisions listed below are included in all Magnet Office modules.  

Updates that apply to specific modules are noted as follows:

Magnet Office Site (MOS)
Magnet Office Topo (MOT)
Magnet Office Layout (MOL)

 Export dwg from Drawing View (All)
o When exporting a dwg from a cross section or profile plot within the drawing editor, the resulting dwg

contained all entities in layer 0.  Revised to retain layers as defined in the drawing editor during export to
dwg.  

 Import PDF (MOS,MOL)
o The PDF file format has been added to the import options.  This option imports the PDF file into the active

project while retaining all layer information contained in the pdf file.

 Raw Data Editor
o Fixed program crash when attempting to copy and paste a record.

 Survey Codes (MOT, MOS)
o Revised support for additional special characters and symbols in the project and global libraries to includes

user request support of  (_) and (-) in the survey codes.  

 Check/Edit Breaklines (MOS, MOL)
o Revised the workflow of the check/edit breakline command by reinstating v2.7 workflow.  

 Cut/Fill Text Labels (MOS, MOT)
o Fixed issue with the cut/fill prefix in the label being reversed.  Cut was prefixed with F and Fill was prefixed

with C.  

 Insert Line
o Fixed issue with distance of line being overwritten by snapped location.  When using a selected point to

define the distance of the line the routine was drawing the line to the selected point instead of just using
the defined distance.

 Insert Arc Commands – Arc by Angle and Arc Tangent
o Routines revised to obey snap settings.  When selecting the points defining the arc the snap settings were
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not being obeyed resulting in points located very closely to the intended snap location.

 Structures and Pads  (MOS, MOT)
o Corrected an issue with the position prompt for both Structures and Pads being displayed in meters

regardless of the project unit setting.

 String/Polylines
o Revised routines to require a minimum of three (3) points before the close option will work.  The close

option would incorrectly duplicate a segment defined by two points when the close option was selected.

 Pad Design
o Revised the default settings to reflect a stationary pad, (non-moveable).

o Assigned default colors for the design elements as follows:

 Cut – Blue

 Fill – Red

 Natural Surface – Grey 

o Revised the Insert Z to reflect the average height of the existing surface.

 Open 
o Corrected issues with *.rep files displaying unrecognizable text when opened in the Survey view.  Report

was being displayed in symbols.

 View Ribbon > Delete Layer
o Corrected an issue with the delete layer option in the View ribbon > Edit Layers group not removing

deleted layers from the layer properties dialog.

 Materials
o Curb & Gutter 

 Corrected issue with data entry for the drop value in curb and gutter definition.  Entry of the drop
value would not allow entry of a decimal value without a whole number.

o Volume material type

 Revised the material unit settings from “Large” or “Small” to “Cu Yd” or “Cu Ft”.

 Topsoil Boundaries 
o Corrected issue with Topsoil Exclusion boundaries not being displayed correctly when located within

another boundary.  
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 Delete Layers
o Corrected issue with the Delete Layer option located in the View Ribbon, Edit Layer Group.

 Empty layers were not being deleted when using the Delete Layer option.
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MAGNET Office Tools 3.3

General

Magnet Tools

 Coordinate System Enhancements 

 Added support for the Polish projections

 Added support for the Macau –MacaoGrid projection and Macao datum

 Added support for the NZ2009 geoid

 Added support for the NZ vertic al datum (NZVD2009
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MAGNET Field V 3.2.1

General

The Following update applies to all versions of the MAGNET Field Solution V3.2.1:

 Addressed an issue when staking linework.  When selecting curved lines for stakeout, the linework would
not be transformed correctly.

 Addressed an issue when exporting data in the APA-SIMA format.  Offset measurements were not
exported correctly.
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MANGET Office V 3.2.1

General

The Following update applies to Magnet Office Topo and Magnet Office Site programs. This software service patch
is an update to MAGNET Office V3.2 and does not require reactivation of the product

Magnet Office 
 Corrected issue when opening large projects.  When saving a project, regeneration of the color fill was being

performed whether Color Fill is On or Off.  The result was a long delay in opening the project.  
 Road View - Profile View and Plotting - Fixed issue with the HI/Lo Points label being reversed when displayed or

included in plotting.

 Fixed the following issues with viewports contained in older version projects when the project is opened in V3.2.  
o The Drawing name on taskbar replaced with random alphanumeric characters.
o In V 3.2, Existing viewports were lost when saving and closing the project.

 Road View - Fixed an issue with stationing on strings and alignments used as offsets in road design. The stationing
along the centerline alignment was not being held on the offset entities.

 Corrected a problem with Drawing tab names and sub drawings when importing older versions of .mjo files into V3.2.
The problem occurred when opening an older project in v3.2, saving and then closing the file. When the file was
reopened in V3.2, the drawing tab names were truncated and existing sub-drawings were lost.

 Corrected issue with raw data in older version projects not being included when the project is opened in V3.2. 

 Corrected issue with project windows name being incorrectly named.  Problem occurred when multiple windows
such as road view, drawings etc are opened within a project.  The tab name was replaced with a hexadecimal name.

 Corrected issue with long Strata Names that exceed 30 characters.  When the Strata Name exceeded 30 characters,
you could not save the project.

Magnet Tools
 Corrected issue with Finnish KKJ coordinate system.  When this system was selected the coordinates of the points

were not displayed.

 Corrected an issue when importing coordinates into a project using a geoid file reference.  The geoid separation was
not being applied during import.

 Fixed issue with localization using one WGS point and one ground of local point.
 
Topcon Exchange for AutoCAD
  Corrected an issue with Enterprise Login and licensing. 
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V 3.2
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MAGNET Field

Configure

 Added the option in the Network RTK configuration to support CMR Corrections with the HiPer SR 

Equipment

 Added support for Sokkia DX-200i instrument

 Added support for Sokkia CX-100LN instrument

Enterprise

 Added support in Enterprise Upload/Download dialogs for the new Enterprise Data Manager.  The List of files
has been replaced with Tree control to show folders and files 

Exchange
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 Added support for code and attributes export to Finnish MMH360 format

 Added support for importing Roads with surfaced defined with zone widths in LandXML files.  

Job

 Added an option under Job/ Save-As to create MAGNET Field job packages ( *.MJFZIP)

 Added an ability to open *.mjfzip form Open Job Dialog

Map

 Added 'HD to last point' to Topo/AutoTopo in GPS mode

Setup

 Significantly redesigned the Reference Elevation/Reference Points routines in MAGNET Field Layout to match
the MAGNET Field approach
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Improvements and Resolved Issues

The following Improvements and Resolved issues, where applicable, apply to all versions of MAGNET Field
software (Field/Site/Layout).

 Addressed an issue when exporting RAW data in APA-SIMA format, the VA is now included in the records

 Corrected an issue when importing drawings (*.dwg) into MAGNET Field; curves in polylines would import as
tangents.  The curves are now imported correctly.

 Corrected an issue when creating custom Classes for observations, the Class definitions are now recognized
correctly.  

 Resolved an issue where photos would not link to a point.   Photos now correctly link to points.

 Addressed an issue in Angle Set reports when displaying the slope distance in the SD Residual field.  The
Residuals are now correctly displayed

 Addressed an issue when importing .dxf files.  In some instances the linework was not shown correctly.

 Corrected an issue when exporting Raw Data.  The resulting HD, VD, HA and, VA errors were not reported
correctly.

 Resolved an issue when updating jobs with Localizations from a previous version of MAGNET Field software. 
The Localization residuals are now shown.   

 Addressed an issue when Exporting  to GTS format, all data is now included.

 Addressed an issue in Resection when ‘Setup for 3DMC’ is checked. Resections performed with  the 3DMC
function enabled would rotate and shift the resection after accepting the results.  

 Resolved an issue when creating and storing a Custom Datum on a Field Controller.  The coordinate offsets
and rotation are now stored after saving the Custom Datum.

 Resolved an issue when creating a surface with a boundary when there are closed breaklines that contain the
triangulation area. Closed boundaries are now recognized.

 Corrected an issue In Set Collection. Set collection now allows for the user to search for the prism if the line
of sight to the prism was lost.  Set Collection will continue once the prism is found.

 Updated Set Collection to use Auto Pointing instead of Auto Tracking after turning to a point.

 Addressed an issue in Resection, the residual calculation now show the correct distance measurement units.

 Addressed an issue in  mmGPS.  The Field calibration routine has been updated to show the calculated values
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for X and Y.  

 Updated Export to the Finnish MMH-360 format.  Codes and Attributes are now exported correctly.

 Updated Export to the Finnish MML-ETRS format.  Codes and Attributes are now exported correctly.

 Addressed an issue when tracking a prism; the last slope distance would be displayed even when the prism
was lost.  MAGNET field software will no longer display the distance value so the user knows the instrument
is no longer tracking the prism.  

 Resolved an issue when using live video on the DS-200i to point to a location.  The instrument now adjusts
correctly for the camera's offset from the horizontal turn axis.

 Improved Resection to address an issue when including Benchmarks with approximate X and Y Coordinate
values.  Users can now include Benchmarks (Vt points) in the resection that have approximate X and Y
Coordinates and the resection will only use the Vertical value(s).  

 Enhanced the job archive function to now create *.mjfzip files.  

 Updated export to Grontmi format to now includes Codes.

 Addressed an issue in RTK stakeout.  Hz and Vt values would not display.

Known Issues

When upgrading MAGNET Field from Version 2.x to Version 3.x, if you have Custom Prisms defined, the
name will be maintained, but the prism constant will be reset to 0.   After upgrading, users should chec k all
user defined Custom Prisms and update the prism constant to the correct offset.  
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MAGNET Office

New Features

New Features

 Added support for new Enterprise Data Manager (All Magnet Office modules).

 Added support of *.mjfzip in addition to *.mjf.zip as a new extension for Field job packages (All Magnet Office
modules).
File> Import

 Introduced Start MMO (Mobile Master Office) for Resurface module only.
Design> RD-M1> Start MMO - This icon will start up MMO program (MMO installation required) 

                

 Added support for Import REB file formats (File> Import). Supports Points, DTM and Road data (Magnet Topo/Site).
File> Import

 Added the option to create Triangles (Arrows) or Tadpoles for Road cut fill slopes.  (Magnet Office Site/Roads
Module)

Alignment> Data Transfer Table> Create Cut Fill Symbols
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(Select color, layer and the string (Left/Right Edge) from where the Cut Fill symbols will be added)

 Added Arc creation options under context menu for Insert Polygon, boundary and pads. (Magnet Topo/Site)

Improvements and Resolved Issues

Resurfacing Module

 Improvements and Resolved Issues in the Resurfacing Module

o Added support for MAGNET Mobile Office NEZC (.txt/ascii) format

o Added a Quick Access Toolbar (QAT) for the Resurfacing module

o Revised the Resurfacing tools default settings to select all strings by default

o Significantly improved  Volume calculation speed

o Updated display options for the profile graph for both position and content

o Revised the cross slope graph to display both design cross slope (solid) and natural cross slope (dotted)

o Revised the marks for start and end stations in the profile window to allow click and drag to edit the
location

o Updated the Profile Lock functionality to work with specified calculated profile(s) only.  This applies to the
following calculations.
 Minimum thickness > set thickness
 Minimum thickness > apply over surface
 Minimum thickness > correct



22

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

 Design > Raise/Lower surface
 Profile > smooth profile
 Profile > average profile

o Added new option in Design> Cross Slope> to update the cross sections based on profile edits

o Add a data display option in Plan and Profile views for:
 Relative slope value of natural surface
 Relative slope value of designed surface
 Paving thickness
 Milling depth

o Resolved the issue of not being able to isolate a single string in the profile view.

o Corrected Set thickness option to change thickness by absolute value instead of relative.

o Revised the Minimum thickness setting to save the entered values.

o Resolved display of  'Unknown Error'  message when exporting to a Roadrunner file.

o Resolved an issue with the Raise/Lower option affecting design cross slopes.

o Resolved an issue with resurfacing limits being cleared after saving a project.  The resurfacing limits are
now retained.

o Resolved an issue with line color change not updating in the slope graph.
 
o Improved zooming options in all design panes of the resurface view.  Zoom extents would not work

consistently.
  
o Corrected the issue with profile labels being duplicated in the Profile design view.

o Resolved an issue with resurface reports not showing milling thickness.

o Corrected issue with display of starting and ending marks disappearing on confirmation of setting.

o Corrected issue with start station not being displayed in the plan and profile resurface views.

o Improved Auto pan to update when dragging the indicator in the profile view.

o Resolved issue with cross slope transition affecting cross slopes outside of the selection range.

o Corrected issue with Profile Lock not holding cross slope between markers.

o Restored previous setting to display strings in the Cross fall Graph in left to right order.

o Corrected an issue with the 'Average Level' setting not accepting input values.  The calculations always
used the default length of 10m.
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Takeoff Module

o Trenching has been updated to add the entered material into the project material library during trench
template definition.

o Site Processing has been updated to check and warn the user when subgrades cross or overlap.

o Resolved an issue with Trench Templates not reading the project materials library and not allowing edits to
the material setting.

General (All Modules unless noted)

o Added the option to 'Save As' Magnet Office v3.0 
Note:  There is no change in the format for magnet office (.mjo) formats between v3.1 and v3.2.  However
there is a format change from v3.0 to 3.2.  This made necessary the option to 'Save As' Magnet Office v3.0.

o Removed 'String by Follow' from the insert ribbon.  Revised the Right click context options for insert String,
Boundary, and Polygon to add the “Follow” option.

o Resolved an issue with the F1 button not opening some pages in Context Help.

o Corrected an issue with Cross Section plots not displaying the cross falls correctly when using the
percentage setting for slopes. (Magnet Site).

o Resolved an issue with Traverse reports that are saved as PDF, being corrupt and unable to open in pdf
viewers.

o Corrected an issue when using the 'Spread Bearing' line annotation option.  The label now displays
Degrees, Minutes, and Seconds correctly.

o Corrected an issue with the Fixed Excel format option when exporting offset report and pavement check
report. The data was  not separating correctly into column or comma separated format.

 
o Resolved an issue with the Symbol setting in Project settings not using the specified symbol.

o Improved the Segment Line/String option.  When 'Prompt for Default  Point Properties' is ON, you can now
confirm the calculated elevation of each point; and have the option to overwrite or accept the calculated
elevation.  

        When 'Prompt for Point Properties' is OFF all points created will have their elevations automatically
calculated.  

        
        NOTE:The elevation calculation is dependent of the elevation flag setting of the existing points in the

entity.  If existing points have the elevation flag turned off then no elevations will be calculated

o Improved the 'Create Parallel Figure' command to resolve areas where segments do not intersect using
valid offset distances.

o Resolved the issue where old cc6 files would not open. The old file is now converted to the new format and
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named:  filename.cc6.mjo

o Resolved an issue with inconsistent import of Neutral files in the Raw Data Editor when incomplete strings
were encountered

o Corrected crash when 'Inquiry Area' was used on areas created by crossing lines. For example, when
crossing lines are similar to a number sign (#)

o Resolved issue with the export to AutoCAD dwg format not retaining the elevation of contours.  Contour
elevations are now retained. (Magnet Topo/Site)

o Corrected issue when exporting annotation to AutoCAD dwg format.  When using the export annotation as
an attribute option, opening the resulting dwg in AutoCAD a DWGdirect error was displayed

o Resolved an issue when creating a ePlan based on Magnetic Meridian not supporting the use of two points.
The MGA rule of three points was being forced. (Magnet Topo/Site Australia only)

o Resolved an issue with the 'Add String' option not working in the Road View.(Magnet Site)  

o Corrected an issue with North Arrow (North Point) not retaining the scale when exported to AutoCAD dwg
format.

o Corrected an issue with Command Aliases not saving when modified.

o Corrected the export to Civilcad ascii 5 format to now export full layer and point names.

o Resolved an issue when transferring a project that contains both a Localization and linework to Magnet
Field.  The linework after opening in Magnet Field was not being displayed correctly.

 
o Corrected an issue in 'Elevate by Leader' where duplicate points were being created along the string.

(Magnet Site)

o Resolved Drawing Editor issues when opening older versions of Magnet Office.  Missing images, table and
incorrect text sizes were encountered.

o Resolved an issue with Cross section plots not displaying the cross falls as ratios when selected. (Magnet
Site)

o Corrected an issue with plot windows. When a plot window was saved as a job, creation of entities outside
the plot window was not working. This occurred regardless of the response to include items outside plot
window when creating the new job.

o Corrected an issue with codes having extra zeros after importing a Leica GSI file into the raw data editor.

o Corrected an issue with Copy and paste of an activation code from an email (PDF).  The complete activation
code was not being pasted into the activation field.

o Revised 'Convert Polyline to String' to no longer prompt to close the polyline.

o Revised Contour settings (styles) so that they can be loaded from both project and library settings. 
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(Magnet Topo/Site)

o Revised Arc and Circle commands to no longer adopt 0 elevation if the elevation field is blank.

o Revised the 'Locate Structure' option to support 2 point arcs.

o Corrected an issue with the 'Select All' option not working when background image is present and
displayed in the project.

Known Issues

In Version 3.1 of MAGNET Office Site and Topo, the Check for Updates feature , located in the Help menu is not working. To
check for updates, users must open MAGNET Tools and run the Check for Updates feature which is located under the Help
menu in Tools.
The Check for Updates feature is not available for MAGNET Office Layout users. To update MAGNET Office Layout, users
must download the latest version located in Topcon Total Care (www.topconcare.com)
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MAGNET Office Tools

Improvements and Resolved Issues

General

o Improved the GNSS Obs report to add an option to display “Used and Ratio” columns.

o Added support of mjfzip extension for job package.

o Resolved an issue with inconsistent elevations on points computed using the Point to Line (PTL) option in
Magnet Field.

o Corrected an issue with HDOP, VDOP and PDOP not being calculated when the “Compute DOPs” setting is
toggled ON.  
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MAGNET Enterprise

New Features

MAGNET Enterprise now provides the following new functionality.

Data Manager

o Create a folder structure below the project inbox
o Create and edit folder structure templates
o View files as a list or thumbnail 
o Copy, move, or rename files
o Use advanced search to find files view
o Preview files
o Preview images

News

o Subscribe to four new RSS feeds – Tips, Field, Office, and Enterprise
o Add a custom RSS feed

Help

o Added online Help
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V3.1
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MAGNET Field

General

GNSS Improvements

 Added the ability to store points with corrected coordinates after Correct Base procedure is run

 Correct Base offsets are now applied for all virtual Base stations generated by a mountpoint

 Supported external UHF radios connected to controller for RTK

 Supported height control in GPS Simulation

 Supported Hybrid Localization using the internal  receiver in a FC500 with Autonomous solution and the
DS200 optical total station 

Optical Improvements
 

 Enhanced tracking with the addition of "Advance Tracking" option setting to Config: Search / Track
Screen

 Updated WiFi connection so MAGNET Field now remembers the last used Wi-Fi instrument.

Other Improvements

 During installation, addition detail was added to the descriptions for optional items

 Added the Virtual Joystick Toggle option to Stake and Topo screens

 Added support for installing to a Windows XP device
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Calculate

 In Enter Plan, when entering direction and distance, the Proposed points and dashed lines in the direction
entered are now shown and provide a visual indicator of the entered values

               

 Added the Calculate button to the title bar in every Cogo task

 Added support to quickly calculate the Angle bisector corner offset in the Corner Offsets feature. 
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 Volume Input dialog: "use alignment" option" added to the volume calculation

Configure

 Added support for external UHF radios to be connected to a field controller for RTK

Coordinate System

 Added Support for German user datums, projections AXIO-NET for TopNETLive

 Added Support for Oregon coordinate reference system (USA)

 Added New Latvian Geoid LV14

 South Korean geoid KNGeoid14

Equipment

 Added support for connecting an external UHF radio to a field controller for RTK

 Enhancement of ’Turning Speed Option to include 1/2, 1/4, 1/8, 1/16, 1/32 deg/sec options
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Optical Equipment

 Added support for the GPT3500L instrument 

Exchange

 Revised export to GC3/TP3 file to export points designated as Control points for “both” vertical and
horizontal in Magnet Tools as Control points in TP3 files, with or without a localization

 Revised the Import of CSV formats with header

 Updated the GT Format Export to include the surface code 

 Updated the SHP/ZIP import to include subfolders 

 Added support in Export Custom Point format to filter the export based on Layer name 
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Edit

 Enhanced the X-Section Template view by adding Grade as a display column

 Added the ability to delete all road data at once instead of having to delete individual com ponents before
deleting the road

Job

 Changed the Default backup interval for Jobs to 2 hours

Map

 Enhanced the GPS Simulator by allowing you to set the position on the map by right-click and selecting
“Set Simulator Here”

 Vertical draw toolbar extended to show zoom and layer controls in a single toolbar   

 Enhanced Map view display options to inc lude Transitions in lines when Road Module is not present
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Reports

 Enhanced Photo Notes to color code the Original GeoTag with a different color than a user m odified
GeoTag

 When printing Field Report to a PDF, the photo has been enlarged to fill more of the page and the text is
now clearer.  

Setup

 Enhanced Reference Line Setup 
o Added the Store button to export setup report 

o Reference line can now be defined by a design point and line azimuth

 Enhanced Resection results report to show residuals in distance measurement units

Survey

 Enchanced Set Collection to allow any number of sets to be collected

     

 Motorized configuration: added the tool icons for motorized instrument under all surveying routines

 With GPS measurements, Added the Toggle "Store as check point? --> Use in weighted average"
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remembers state for the next point to allow storing of a Weighted Average
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Stake

 Added Extended grade feature to Stake options

                     

 Enhanced Stake Surface to maintain zoom state when switching from main map and stake surface

 Added "HD to Last point" label to Stake map to show the distance 

 Added the ability to quickly stake line intersections directly from the map by selecting two lines, then
right click to access the Stake Intersection option

                  

 Enhanced Live Screen Value display options by adding Point Name, Code, and Note as label values
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 Stake Report includes Stake Offset values for reference points
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MAGNET Office

New Features

 Cross Sections from DTM - Added a new option to extract strata surface cross sections when creating
cross sections for road and site design.  (MTO)

 3D Toggle and 3D Tab new options:
o Select Objects
o Change object properties
o Edit Point elevation
o Compute Elevation Ribbon Group:

 Catch Points
 Point on Grade
 Intersect Grades

o Elevate by DTM Ribbon Group:
 Grid Points
 Interpolate DTM – set elevation of points by active dtm
 Elevation Difference
 Create Points from DTM

o Create/Edit DTM Ribbon Group:
 Create DTM
 Create DTM by Depth Range
 Create Cut/Fill DTM
 Merge DTMs
 Merge by Elevation
 Raise/Lower DTM
 Modify DTM
 DTM Tools:

 Import DTM
 Export DTM
 Adjust DTM Slope
 Update DTM
 Check DTM
 3D View – works as 2d/3d toggle
 Convert Contour to String (by range)
 Create DM Boundary
 Extend DTM

o Edit Mesh Ribbon Group
 Add Triangle:

 Swap Triangles
 Show Triangle Properties
 Check/Edit Breaklines
 Insert Breakline
 Highlight Points set to use in Surface
 Decompose Triangle

 Delete Triangles:
 By Line
 By Boundary
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 By Length or Angle
o Boundary Ribbon Group:

 Create Enclosing
 From Polygons
 Create List
 Edit Lists

o Volume Ribbon Group:
 Compute
 Batch
 Quick

 Printing – Added a new option to include/exclude footer.
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 Added optional color Legend for cut/fill or elevation zone shading in the Survey, 3D and Drawing
views

 
          Example showing Survey View with Legend

              

        Example showing 3D View with Legend

       



41

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

         
          Example showing Drawing View with Legend

                    

 Legend in drawing view is user defined for width and height.  
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 DTM Settings – Added a DTM report option.

 Added a new option to update Plot windows after a translation/rotation is perform ed.  A prompt to
update the plot windows during the translate/rotate c ommand is provided

 Added a new insert string option, "4 Sided figure".  Creates a 4 sided figure from two lines or a two
segment string.
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 Insert Points – Added new option “Corner Offsets”.  This option creates offset points from
corners and provide optional creation of diagonal point from corner.  

 Insert String – Added new option "String by Follow".  Using this function provides the option to
create a string based on existing strings.  Option prompts for entry point and exit point along
existing entity.  The right click context menu for polygons and boundaries has been updated to
include the follow option.
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 DTM Tools – Added new option to extend DTM.  This allows points outside the DTM boundary to
be selected and added to the current DTM.  

     

 Added new option to save project as a Magnet Office version 3.0 file.
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Improvements

 Cut/Fill Improvement
o Cut/Fill dtms now display in red lettering in DTM settings dialog
o Cut/Fill values now can be added in the survey view.
o Added “Zero Contour” display setting in DTM setting dialog and Surfac e Ribbon.
o Cut/Fill view has been removed; Cut/Fill DTMs can now be displayed in the Survey view

and used with plot windows for printing/plotting.

                               

 Added Browse Folders option, in the Help Ribbon, for quick access to the Program Folders
o Data Folder
o Library Folder
o Temp Folder 
o Current Project Folder

 Updated TP3 Import – Import no longer creates points at string vertices that have no elevation.
Imported strings without elevation are imported as polylines.

 Updated TP3 Export to support alpha point names.

 Catch point routine moved from the Design Ribbon to the Surface Ribbon.

 Improved road template design to support the input of slopes in ratio formats, H:V and V:H.

 Revised right click context menu to include snaps.

 Improved Alignment by Element routine by:
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o Auto populating the alignment name field
o Supporting element edits by picking on the alignment element.

 Updated Edit Group Properties dialog to include elevation setting for text.  Intended for use in 3D
views.

 Updated export to dwg to include arc to chord distance setting for 3D polylines.

 Updated all Elevate options to set the Use in Surface option to ON for points.

 When inserting objects, enabled breakline toggle in the data input toolbar if the selected point has
elevation.

 Improved Insert String and polyline options by providing tangent arc setting after the entry of a
previous tangent arc.  This support creation of compound curves and reverse curves.

 Improved Cut/Fill color settings to allow for user defined shading interval.  Interval is entered and
the auto fill option selected to create new color shading scheme.

Import/Export

 Revised export to GC3/TP3 file to export points designated as Control points for “both” vertical and
horizontal in Magnet Tools as Control points in TP3 files.

Resolved Issues

 Corrected issue with c lipping symbols not working on paper print/plots and when printing to a pdf
file.

 Corrected issue with Unicode characters being displayed in sewer library dialogs when importing
libraries from previous Magnet Office versions.

 Corrected issue with toolbars not retaining positions when c losing and restarting the program.

 Corrected issue with toolbar layout export and save.  Layouts are not able to be exported and
saved.

 Corrected issue with Drainage projects not opening in Magnet Office v3.0.1 running on a 32 bit
Windows system.

 Corrected issue in drainage module Plot menu.  Printed Reports and Plot Calc was not working.

 Corrected issue with incorrect text size in profile and cross section drawings when opening
projects created in previous versions of Magnet Office.  Text size was not correctly displayed.
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 Revised export to dwg from within the drawing editor to retain existing layers and layer
properties.

 Corrected program crash when creating line types with text or circles.

 Corrected program crash when using Segment Arc.  Pressing escape during use of the segment
arc option was causing a program crash.

 Revised segment line to correctly display the interpolated elevation along the line when the line
end points have elevations.  

 Corrected issue with running the Elevation Difference command causing program crash.  

 Correct issue with Unicode characters displaying in the Control Points dialog.  Unicode characters
no longer are displayed.

 Corrected issue when importing *.hal file.  "Tangent to previous" setting is now being recognized.

 Corrected issued with the inquiry stakeout report.  Some setting options were causing a program
crash when closing the report.  

 Revised Legal Description writer and Textstyle libraries to correctly display characters.  In some
instances Unicode characters were displayed.

 Corrected issue with Traverse editor having blank fields populated with invalid numbers.  

 Corrected issue with the Offset command.  Offset point elevations were being incorrectly
calculated.

 Revised the De-Select by option to create list when list option toggled on.  List was not being
displayed.

 Corrected issue with user defined contour settings not being written to the contour style library.

 Corrected issue with Raw Data windows nor retaining size settings when project saved.

 Corrected issue with entry of Horizontal Alignments and curves.  When entering in a speed that is
not an increment of the speed library being used during spiral curve design, the program would
freeze.  Pressing escape returned the user to a normal screen view.  This issue has been
addressed.
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MAGNET Takeoff

 Magnet Takeoff – A new module than contains tools to aid the user in the bidding process.  MAGNET
Takeoff includes tools for calculating material costs and cut/fill volumes.  

Module includes the following functionality:

o Material library – User defined program and project material libraries.  Supports material type and
cost definitions.

o Assign Materials – Interactive and graphical interface for defining layer groups and assigning
materials to layers for calculations of subgrade, count, length, and curb & gutter volume and
costs.

o Use boundaries and polygons for topsoil removal and replacement area volume and cost
calculations, as well as subgrade material volumes and costs.

o Site processing graphical interface for easy specific ation of boundaries, subgrades, boundaries of
interest (BOI), roads, and trenches.  Report volumes and costs for entire site or by
boundary/polygon.

o Site balance option.
o Borehole support – Enter/edit borehole information for geologic strata information.
o One button strata dtm creation for use in cut volume calculations.
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 Create trench stings and networks – Create trench dtm, calculate cut volume from trench, calculate
volume and cost of trench composite fill materials. 

 Trench templates – define and retain trench templates defining depth, width, pipe size, bottom offsets,
tie slopes and composite fill materials.

 Pipe depth report – reports the linear distance for depths encountered in trench design.
 Pipe depth Zone – User defined color depth zone display.
 Pipe depth plot
 Inclusion/Exclusion area definitions.
 Volume and cost reporting
 Total site volume/cost calculation – calculate roads, trenches, subgrades, count & length materials,

topsoil removal and replacement areas and cut/fill volumes and costs in one total site volume/cost
report.

 Assign materials to road subgrades within the road design view.
 Export Volume and material information to Magnet Mass Haul module for mass haul calculations,

diagrams, and haul optimization planning.
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Total Site Data Preparation and Calculation Interface

DTM showing Design surface with subgrades applied.
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MAGNET Mass Haul

 Magnet Mass Haul –  Use MAGNET Office Mass Haul for mass haul analysis in the design and/or bid phase.
Data on mass usage and haul distances improve the accuracy of cost estimates by providing data based on
calculations instead of estimates.

                       

Key features:

 Mass haul diagram
 Quantity and alignment geometry transfer from MAGNET Office
 Support for several chainages/alignments/road lines
 Balance cut and fill
 Support for Shrinkage and Swelling (Bulking Factors)
 Refining e.g. aggregates and clay
 Disposal and borrow analysis
 Crushing
 Mass haul distance and cost optimization
 Construction zone division
 Text reports on mass usage, haul distances, and costs
 Calculating mass balance and optimized haul distances
 Map view with multiple road line support
 Assisted project creation
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 Quantity import from Excel
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MAGNET Office Tools

New Features

General

 Implemented Snaps and Snap mode.

o Located in the Add Ribbon
o Click on the Snap Mode icon to activate snap mode.

     

o Snaps are also located in the Right Click menu
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 Snap indicators show the snap location with an x.  When the cursor is moved near the snap location a
box will display.  Clicking when the box is displayed will select the snap.

 Data process updated to support the Magnet Field Two Distance Offset routine.
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Import/Export

 Revised export to GC3/TP3 file to export points designated as Control points for “both” vertical and horizontal in
Magnet Tools as Control points in TP3 files.

Coordinate Systems

 Added support for German user datums, projections AXIO-NET for TopNETLive

 Added support for Oregon Coordinate Reference System (USA).

 Added Latvian Geoid LV14

The GridToGround dialog has been revised to allow for the specification of the direction for scaling.  Options
to apply the scale factor from Grid to Ground or Ground to Grid are available

 



56

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

Known Issues - V3.1

MAGNET Office

 There is an issue in MAGNET Office when exporting data to a .mjf (MAGNET Field Job) when the job
contains both a localization and linework.  When exporting, select the "as background" option so the
linework will display properly when the job is opened in MAGNET Field/Site/Layout.  

 There is an issue in MAGNET Office when exporting a road to a .mjf (MAGNET Field Job) that contains a
Vertical Alignment.  When the job is opened in MAGNET Field, the grades shown for the Vertical Elem ents
are not displayed correctly. Users should export the road in MAGNET Office V3.1 as a .tp3 format file and
the Vertical Aligment element grades will display properly.  

 There is an issue in MAGNET Office when exporting a .tp3 file from a project with a Coordinate System.
Users should UNCHECK the 'Coordinate System Toggle' before creating the .tp3 file.   

 There is an issue in MAGNET Tools when importing a MAGNET Field job with digital level data that  has
multiple observations to the same point.  In MAGNET Field, the first observation is used to calculate and
report the elevation, whereas in MAGNET Tools, multiple observations are averaged to compute an
elevation.  As a result, users may notice a slight difference in the final reported elevation of a point.  

 There is an issue in MAGNET Tools when using the 'Import from Internet' function to import data from
NGS Datasheets.  The coordinates shown for CORS stations may not match the values shown on the
datasheets.  Users should check the values and then update the coordinate values manually if they do
not match.  The same issue also exists when using the 'User Friendly CORS' function after importing
RINEX files.  
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MAGNET Field V3.0.1

General

The Following update applies to all versions of the MAGNET Field Solution V3.0.1:

 Addressed an issue in the Software Updates feature.  The fix will allow users to update from  V3.0.1 to
future versions of MAGNET Field products.

 Addressed an issue when collecting offset points and exporting raw data files (raw, rw5, sdr).  The
output file has been updated to correct the coordinates of the offset points.  

The following update applies to MAGNET Field Layout:

 Added the Sokkia GCX2 GNSS receiver to the list of available GPS+ Equipment Options.

Known Issues

MAGNET Field solutions known issues:

 There is an issue with the display of the vertic al residual values (rV) in Localization when only 1 Vertical
point is held in the localization.  When a project with an existing Localization is upgraded to Version 3.0
and higher, the Vertical residual values (rV) are not displayed when you select Setup>Localization. To
display the rV values, exit and reenter the Localization sc reen and the rV values will display properly
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MAGNET Office V3.0.1

General

The Following update applies to all versions of the MAGNET Office V3.0.1.  This software service patch is
an update to MAGNET Office V3.0 and does not require reactivation of the product

NOTE: There is an issue with the Auto-Update feature in MAGNET Office Layout.  If the 'check for updates'
feature is run, MAGNET Office is installed and will run in Demo mode.  To update MAGNET Office Layout to V
3.0.1 you should go to www.Topconcare.com and download the update and run the install from your
desktop.  

This patch addresses the following critical items identified by users after the initial release of version 3.0.  

 Startup – When starting the product with the Startup Wizard active, pressing the red X to close the
Startup Wizard would result in the program window being blank with no toolbars or ribbons.  

 Transfer of a Magnet Tools project containing a localization to Magnet Office resulted in the Magnet
Office project not retaining the localization method defined in Magnet Tools or Magnet Field.  

 When using Polygon Filling mode, solid linetypes would not work as a filling option.  

 Using Title blocks with images resulted in the colors for the images being inverted.

 Title blocks using xtb format were missing text and images.

 Point annotations were not displayed in the drawing editor/plot window.

 Service string descriptions were not being converted correctly resulting in the display of an invalid
description.

 When creating intersections and profiles from strings an unreadable message was being displayed.

 Intersection designs from V2.0 were not being converted into V3.0.

 Update Curb/Kerb was not working.

 The ability to rename intersection designs would fail.

 Export to AutoCAD – When exporting to dwg with the option to export point annotation as attributes
resulted in incorrect attributes in dwg format.

 Manual Alignment Entry - Using manual alignment entry to c reate alignments with Spiral Curves
resulted in incorrect coordinates for the IP's.    

 After placing the computer in sleep mode, when restoring the active session, the toolbars in Magnet
Office were blank.

 When exporting to dwg format, text would not hold its original position.

 Cut/Fill DTMs are not being retained when upgrading projec ts from previous versions of Magnet
Office.

 Closing the List Data report window resulted in a program crash.

 Profiles created in previous versions of Magnet Office were not being converted and retained in
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Magnet Office v3.0.

 CCX files containing large DTMs were unable to be opened in Magnet Office v3.0.  

 Unable to select a polygon created or contained within another polygon.

 When opening alignments created in a previous version of Magnet Offic e, all empty fields were
populated with a value of one (1) meter or its unit equivalent.  

 Using the Arrow to set layer properties did not work.
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V3.0
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Field

General

New Installer:

MAGNET 3.0 now has a new modern installation wizard that supports the following features:

o Added automatic check in the web and installation of most recent language file and Context Help
updates from the installer for both PC and Controllers

o Added an ability to use custom language file and Context Help. Custom language and help files
can now be selected during installation for both PC and Controllers.

o New Web Installer with install platform auto-detection.  
o Enhanced Option to run the install directly on the field controller 
o Timesaving ability to do an online check for the latest available Language, Context Help,

Projections and, Geoid Models.  

o Modern time saving installation wizard also checks for the newest available update/version 
o Added support for automatic reactivation after updates

Update Notifications

 MAGNET 3.0 includes support for automatic update notifications.  The Check for Updates feature shows a
list of available updates with release notes and allow users to quickly update their installation of MAGNET
Field 
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Calculate

Improvements:

 Added Traverse Closure Routine that allows users to quickly calculate the raw closure on a Traverse.  

 Added a Vertical Curve calculation routine. Options available when calculating a Vertical Curve include
input Curve Length, High/Low Elevation and Point on Curve. 

 

 Enhanced support in Surface feature includes Creating Surface from Areas with non-convex areas 

 Enhanced support for Bidirectional Volume Calculations in Surfaces

 Enhanced Linework Offset routine now supports Grade and Rotate Options

 Enhanced Traverse Adjustment Report includes Target type and Prism Constant

 In Enter Plan, the current entered line is now shown as a bold line 



63

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

Configure

Improvements:

Equipment

 Added support for the DS-Ai inc luding integrated scanning for OnBoard and Controller 

 Added support for the Sokkia GCX2 receiver

 Added Support for the Sokkia Atlas Receiver

 Added support for the CR-G5 antenna

Other

 Added support for Ad-hoc WiFi connection on Windows 8 Controllers

 Enhanced RC control to allow Hybrid Search when available.  

 Field Controller date and time are now updated from GNSS

Coordinate System

Improvements:

 Added Support for Geoid EGM08-REDNAP(Spain)
 Added the new Transformation - JTSK03-JTSK for Slovak Projection

Equipment

GNSS Enhancements

 Added support for NTRIP 2 via the Receiver Modem

 Added support for Repeater mode for SATEL and Digital UHF Modems

 Added the Quick Radio option for Rovers

 Added support in the HiPer SR Base-Rover for Dual SIM cards

 Enhanced Skyplot and Satellite List to show different c olors for SBAS, QZSS, GALILEO and, Beidou
systems

 Enhanced cell support now show the operator when connecting to a cellular network provider
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 Added support for SBAS tracking option

 Added filtering for DION smoothing mode, allowing the user to use a single Topcon rec eiver to compute
smoothed and consistent absolute position solutions.  

 Enhanced Session Check to allow computation type for Check Two Coordinates feature

Optical Enhancements

 Enhanced control with Robotic EDM.  Instruments no long automatically start in reflectorless mode

 Enhanced Conventional TS support allows users to manually enter Slope Distance for HA/VA
measurements

 Added the ability to individually control Auto-Aim and Auto-Turn options

 Added Robotic Simulation mode

 Enhanced control for Sokkia instruments now includes Tilt Correction

 Added the Laser Pointer Option on the prism search bar when RC is not available

 Enhanced instrument configuration support to allow input of humidity

 Added Quick/Precise support for the LN-100

 Added the ability to enter Prism constants with decimal precision

 Added Quick/Precise options for Direct/Reverse survey mode

 Added Target Type of Prism Constant to Backsight and Resection Reports

 Enhanced styles support now includes a Motorized Survey style

 Added Touch Slide support for Total Stations with Video support

Exchange

Improvements:

 Added support for Autodesk ACAD 2015 files

 Enhanced Export options now allow users to export Points by Layer
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 Added support for exporting Localization report in Job Units

 Enhanced support when exporting KOF format, header and survey styles are now included in the file

 Added support for Import/Export of SBG Geo file format

 Enhanced support for Berlin GNSS-Messprotokill report.  The report is not loc alized and renamed to
GNSS Raw Report

 Enhanced support of Custom Code Styles in all Point Report formats and Custom Raw GPS/TS formats 

 Added Antenna Ht field to Text Custom QC Format

 Added for export of depth and GNSS height measurements to custom raw formats

 Added support for export of Station ID and Physical Station ID to Custom Raw GPS and Points QC
formats

Edit

 Enhanced Quick Codes to allow users to define Quick Code Groups.  Users can now define any number of
Quick Code groups for specific job types and quickly select the appropriate set of Quick Codes for their
task directly from the Map.  Quick Code groups may be edited after they are defined, so users can
update the group at any time.  
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 Enhanced Attribute Support allows users to define Persistent Attribute options so the next m easured
point(s) with the same code retain the current Attributes
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 Added the ability to restore deleted measured points from the Edit Raw Data list

 Added the ability to join linework by common endpoints.  Lines can be selected directly from the Map or
list and common endpoints are automatically joined.  Background lines can also be used as well.  

 Enhanced Coordinate display option now supports the options DDD.ddddd and DD.MM.m mm for Lat and
Long coordinates

Job

 Enhanced Job setup now includes the ability to copy the current Instrument Setup to a new Job.  
o Additional enhancements include copying a resection setup to a new job.  

Imaging 

Advanced Imaging Module:

MAGNET 3.0 now offers an Enhanced Imaging Module to support Topcon's imaging solutions including
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support for Topcon's DS-200Ai imaging total station and the IS ImagingStation Series.  

• The initial release of the imaging module includes software functions of:
o Feature Scanning
o Grid Scanning
o Panoramic Image Capture
o Scanning data viewer

Map

Improvements:

 Enhanced Map navigation tool includes a moving direction setting in Stake and Topo Routines.  Users can
set the map to rotate to their direction of travel.  

 Enhanced Layer control now allows users to turn on/off multiple layers, sort layers by any property or by
drawing order and also delete multiple layers, 

 Support for closing lines in Map view using the snap toolbar

 Added the ability to selec t multiple lines from the background map

 Added the Snap Toolbar to all map screens where you can select a point

 Enhanced Map display to support the display of Stations and/or Transition points

 Enhanced text display on map to now support Small/Med/Large and Bold display options

 Roads without Vertical Alignments are now drawn with x-sections on the 2D Map

 Enhanced 3d map display now supports vertical exaggeration
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 Added Layer name for all objects in precise selection dialog

 Enhanced instrument setup display now shows the optical instrument orientation on the map

 Added the ability to define and display Avoidance areas on the m ap.  Audible alarms may also be set for
avoidance areas

Enterprise

Improvements

Redlines:  

MAGNET Field now supports Redlines generated in MAGNET Enterprise.  
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• Redlines edits that have been initially created within MAGNET Enterprise cloud service can now
be delivered directly to field crews members.

• This feature allows users to define areas that need additional data or to visually communicate
any critical project information

Timecards and Schedules:

    

      Timecard Display within MAGNET Field
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      Assigned Tasks within MAGNET Field

• MAGNET Enterprise allows Project Manager's to create Schedules and assign project related
tasks to their field crews.

• MAGNET Field allows field crew members to synchronize when they log in to MAGNET
Enterprise, connect to a proejct and instantly receive all assigned Tasks and Schedules.  .

• The Timecard feature allows users to submit hours against each task, which is summarized in
MAGNET Enterprise Project Manager feature.  

Reports

Field Reports:

• MAGNET Field v3.0 introduces the ability for users to create Field Reports to document critical project
conditions.  Users can insert screen captures or use the digiatl camera within the field controller to
capture supporting photos.  

• Drawing tools further allow the user to optionally highlight and potentially add descriptive text directly on
image to convey project details to management and office staff.
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PDF Support
 PDF Viewer in Field Reports allows users to view and export Field Reports in PDF format

Survey

Improvements:

 Enhanced ability in X-Section Survey to c hange the next station manually to the desired value

 Added the option to define an Elevation in Auto Topo

 Enhanced Set Collection to allow users to specify the prism and target type for each predefined point.  

 Enhanced Set Collection to provide Traverse support

 Added the ability to edit point names from the Topo Map using the Point Attributes button

Stake

Stake Grid:

Added the ability for users to define a custom grid for project site stakeout.  MAGNET Field will automatically
create 'phantom' points for navigation to the calculated grid intersections.  
Users can define the grid spacing, orientation(direction) of the grid and, grid boundary.  

   

Additional Features:
 Added the ability to extend staking beyond the endpoint of a line and allow the user to continue along

the current slope or, starting at the endpoint, define a new slope.  
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 Enhanced Stakeout of linework to inc lude 3D linework

 Added the Hybrid Switch to Stakeout

 Added the ability for users to define a Reference Centerline in all routines as the reference line for station
and offset values 

 Enhanced Stake Line now shows distance to both the start and endpoints of the line

 Added support for Station Equations.  Users can create station equations while standing at an active
jobsite.  

 Added support for Custom Station Intervals.

 Added a user defined scale for the Stake Light Bar

 Enhanced data view to include Skew Angle

 Enhanced Stake Line to display distance and slope

 Enhanced Stake Offset Line, Intersec tion and Spiral to allow users to measure start points
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MAGNET Field Layout

General

The Following Enhancements apply to MAGNET Field Layout

 Added map view and advanced page for Reference Points setup

 Added configurable menus to allow users the ability to have customized user interface.  
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MAGNET Field Site

General

The Following Enhancements apply to MAGNET Field Site

 Added Enter Plan 

 Added the ability to Offset Multiple Points 

 Added configurable menus to allow users the ability to have customized user interface.  
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MAGNET Field GIS

General

The Following Enhancements apply to MAGNET Field GIS:

 Updated the default GPS receiver to the HiPer SR

 Added 'Field Advanced GIS" to the activated modules list when GPS+ module is purchased
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MAGNET Enterprise

General 

The following enhancements were deployed with MAGNET Enterprise 2.7 (Deployed January 30, 2015)

 Application desktop is now HTML5 with all widgets still in flash

 Google Maps are now used in the MapWidget

 Timecard management has been updated with the following:
o Daily Percentage form removed
o Week/days/date indication improved
o Task completion data editor removed
o Task completion rule changed to task percentage driven rule
o Confirmation view added for the user to double check the data before submitting
o It is now possible to see non-scheduled task in the timecard and submit hours for them

 Hour unit of measurement is now available for task c reation.
-
 Project Accounting columns can be sorted
- 
 Proposal management reviewed

o The first proposal is automatically set as active ( if not created from a template )
o The system will warn the user if a proposal is not active when the view is left

 In proposal definition phase the task order can be changed via drag & drop and the obtained order is
used as the initial sort in the application

 Schedule information box has been updated to inc lude the assignee.

 Addressed an issue with Chat 

 Added full support for the German language
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MAGNET Mobile Exchange

General

Improvements:

 Enhanced support for devices that now includes reporting device location to Enteprise Asset Manager
 Enabled multiple selection when browsing for files uploading and downloading files
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MAGNET Mobile Exchange for Ag

General

Improvements:

 Includes All MAGNET Mobile Exchange changes 
 Requires MAGNET Enterprise for Ag service

 



80

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

MAGNET Office Site

New Features

The following NEW Features apply to MAGNET Office Site

 View > New 3D view introduced (View > toggle and Add Window)
o Allows current job data to be viewed in 3D without exporting
o 3D view is updated if survey data is modified

 3D View tab has been added to the General Display settings (hot button).  This determ ines where to
display non-elevated data when in 3D view

 Upgrade DTM Color Fill table

 Introduced DTM Color Fill legend display

 Updated interface to allow for multi-monitor support

 Support for Station Equations
o Design>Roads>Edit Alignments>Station Equations allows users to c reate station equations for

alignments

 Added a new control for station field if a station equation is applied

 Added support for Alignment by Elements.  Alignments can now be created using elements: straights/
curves/spirals/composite spirals

 Added support for non-tangent c urves in all manual alignment editors and Deed description Entry/Editor

 Added an option to show cut/fill area with Tadpoles (slope direction arrows)

 Increased the limit for Road surfaces (Design = unlimited, Subgrade = 20)

 Surface TYPE introduced for Roads surfaces.  
o Natural
o Design
o Subgrade
o Strata

 Added Support for Swedish station format ("/") in Program/Project settings

 Enhanced support for Elevating Pads.  Create pads from existing closed entities and elevated pads from
text within the pad area.  

 Enhanced support to Extract strings and surfaces from cross section plots/drawings.  

 Added the ability to assign layers to a group.  
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 Added the ability to Modify Open String and Closed string polylines

 Added the ability to window or outline with a polygon a specific area and then delete all objects inside or
outside of the windowed area

 Added the ability to spec ify multiple inclusion or exclusion areas in Surface>Create DTM  

 Added 3D view to Cut/Fill View

 Added the Print option to Cut/Fill View

 Added the ability to create points at the intersection of linework

 Added the option in Join Linework to Join nearest or by point order

 Added the option to add text m idway on a String/Polyline/Alignment

 Enhanced Inquiry to allow the following:
o Select Multiple Areas and labels and reports multiple areas in the job
o Display elevation details (Mean Elevation) of selected points
o Report details of selected linear entities (distance, layer, total distance)

 Added the ability in Snap Mode to snap in 3D.  This allows point elevation interpolation along a line when
using snap

 Added the ability to set a new layer active if set to current

o Added a new 'Set Properties option

 Enhanced Changing Layers/Codes so the user no longer has to hold the SHIFT key.  The CRTL key can
now be used to hold the current settings

 Enhanced the Elevation flag logic.  Introduced blank/null elevation and removed the elevation flag during
input.  The default elevation is set to blank

 Improved insert point properties.  

 Enhanced DTM Contours settings and introduced Zero contour flag.  

 Added an Avoidance Layer setting.  This was introduced to allow import/export of Avoidance settings
from MAGNET Field, MAGNET Tools, 3DMC

 Enhanced Project Settings.  A new setting for Shade Polygons was introduced

 Added a Module specific Quick Access Toolbar

 Enhanced point number limit to 64 characters and Point Code to unlimited characters

 Added additional language settings.  Languages available are now listed
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 Added a check for language update 

 Added local language support for EULA and the License Agreement (when available)

 Added 64 bit version 

 Added an upgrade for Unicode

MAGNET Enterprise Project Manager

 Added support for Redlines generated in Enterprise

 Added support for Timecards created in Enterprise

 Added support for Tasks created in Enterprise
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MAGNET Office Topo

New Features

The following NEW Features apply to MAGNET Office Topo

 View > New 3D view introduced (View > toggle and Add Window)
o Allows current job data to be viewed in 3D without exporting
o 3D view is updated if survey data is modified

 3D View tab has been added to the General Display settings (hot button).  This determ ines where to
display non-elevated data when in 3D view

 Upgrade the DTM Color Fill table

 Introduced the DTM Color Fill legend display

 Updated interface to allow multi-monitor support

 Support for Station Equations
o Design>Roads>Edit Alignments>Station Equations allows users to c reate station equations for

alignments

 Added a new control for station field if a station equation is applied

 Added support for Alignment by Elements.  Alignments can now be created using elements: straights/
curves/spirals/composite spirals

 Added support for non-tangent c urves in all manual alignment editors and Deed description Entry/Editor

 Increased the limit for Road surfaces (Design = unlimited, Subgrade = 20)

 Surface TYPE introduced for Roads surfaces.  
o Natural
o Design
o Subgrade
o Strata

 Added Support for Swedish station format ("/") in Program/Project settings

 Enhanced support for Elevating Pads.  Create pads from existing closed entities and elevated pads from
text within the pad area.  

 Added the ability to assign layers to a group.  
 
 Added the ability to Modify Open String and Closed string polylines

 Added the ability to window or outline with a polygon a specific area and then delete all objects inside or
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outside of the windowed area

 Added the ability to spec ify multiple inclusion or exclusion areas in Surface>Create DTM  
o Added the ability to create boundaries during DTM creation

 Added 3D view to Cut/Fill View

 Added the Print option to Cut/Fill View

 Added the ability to create points at the intersection of linework

 Added the option in Join Linework to Join nearest or by point order

 Added the option to add text m idway on a String/Polyline/Alignment

 Enhanced Inquiry to allow the following:
o Select Multiple Areas and labels and reports multiple areas in the job
o Display elevation details (Mean Elevation) of selected points
o Report details of selected linear entities (distance, layer, total distance)

 Added the ability in Snap Mode to snap in 3D.  This allows point elevation interpolation along a line when
using snap

 Added the ability to set a new layer active if set to current

o Added a new 'Set Properties option

 Enhanced Changing Layers/Codes.  The user no longer has to hold the SHIFT key.  The CRTL key can
now be used to hold the current settings

 Enhanced the Elevation flag logic.  Introduced blank/null elevation and removed the elevation flag during
input.  The default elevation is set to blank

 Improved insert point properties.  

 Enhanced DTM Contours settings and introduced Zero contour flag.  

 Added an Avoidance Layer setting.  This was introduced to allow import/export of Avoidance settings
from MAGNET Field, MAGNET Tools, 3DMC

 Enhanced Project Settings.  A new setting for Shade Polygons was introduced

 Enhanced point number limit to 64 characters and Point Code to unlimited characters

 Added additional language settings.  Languages available are now listed

 Added a check for language update 

 Added local language support for EULA and the License Agreement (when available)
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 Added 64 bit version 

 Added an upgrade for Unicode

MAGNET Enterprise Project Manager

 Added support for Redlines generated in Enterprise

 Added support for Timecards created in Enterprise

 Added support for Tasks created in Enterprise
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MAGNET Office Layout

New Features

The following NEW Features apply to MAGNET Office Layout

 View > New 3D view introduced (View > toggle and Add Window)
o Allows current job data to be viewed in 3D without exporting
o 3D view is updated if survey data is modified

 3D View tab has been added to the General Display settings (hot button).  This determ ines where to
display non-elevated data when in 3D view

 Updated interface to allow multi-monitor support

 Added support for Localization (Survey>Control Points)

 Added Global Codes and Command Codes settings to the Survey Menu

 Added the ability to create points at the intersection of linework

 Added the option in Join Linework to Join nearest or by point order

 Added the option to add text m idway on a String/Polyline/Alignment

 Enhanced Inquiry to allow the following:
o Select Multiple Areas and labels and reports multiple areas in the job
o Display elevation details (Mean Elevation) of selected points
o Report details of selected linear entities (distance, layer, total distance)

 Enhanced Snap Mode to inc lude 3D snap.  This allows point elevation interpolation along a line when
using snap

 Added the ability to set a new layer active if set to current

o Added a new 'Set Properties option

 Enhanced Changing Layers/Codes.  The user no longer has to hold the SHIFT key.  The CRTL key can
now be used to hold the current settings

 Enhanced the Elevation flag logic.  Introduced blank/null elevation and removed the elevation flag during
input.  The default elevation is set to blank

 Improved insert point properties.  

 Enhanced Project Settings.  A new setting for Shade Polygons was introduced

 Enhanced point number limit to 64 characters and Point Code to unlimited characters



87

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

 Added additional language settings.  Languages available are now listed

 Added a check for language update 

 Added local language support for EULA and the License Agreement (when available)

 Added 64 bit version 

 Added an upgrade for Unicode

MAGNET Enterprise Project Manager

 Added support for Redlines generated in Enterprise

 Added support for Timecards created in Enterprise

 Added support for Tasks created in Enterprise
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MAGNET Office (Layout, Site, Topo)

Improvements and Revisions

The Following Improvements and Revisions apply to the MAGNET Office Solution:

Legend

MOS - MAGNET Office Site
MOT - MAGNET Office Topo
MOL - MAGNET Office Layout
ALL - All Products

 Magnet Office no longer supported on Windows XP (ALL)

 Removed Save As ccx, cc6, and older versions. MAGNET Office V3.0 files are not compatible with older versions of
MAGNET OFfice.

 Improvement with Manual Road entry> Create DTM if start chainage not zero (MOS)

 Strings and Polylines now includes Convert button in Edit dialog to convert to other closed areas –
Polygon, boundary, pad, lot) (ALL)

 Option to select multiple files for Design> Cross section> import xsect file (MOS, MOT)

 Import custom cross section file support for Mfield (MOS, MOT)

 Survey module background color set in preferences is now reflected in all modules except drawing.
(ALL)

 Properties toolbar no longer blank when multiple selection made (ALL)

 Combine Sitelink and Enterprise ribbon to Cloud Connections (MOS, MOT)

 Properties button disabled if no selection made (ALL)

 Point NOTE display info only displays if a note is available (ALL)

 Users can now delete attributes (text) from selection on screen (ALL)

 Rename Enquire to Inquire (ALL)

 Updated logic sequence for Create parallel string command to allow updating settings or repeating
option on other strings (MOS, MOT)

 Surface> Create Enclosing Boundary updated to support points and other entities inc luding polylines
and arcs (MOS, MOT)

 Extract cross section dialog setting held for each alignment (MOS, MOT)

 Catch Points moved from Design to Surface menu
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Catch Points - Add option to deactivate prompt for point properties (MOS, MOT)

 Create alignment from lines now supports polylines (MOS, MOT)

 Program settings> Preferences> Default Beep, updated to handle on/off for all default beep sounds in
MO (ALL)

 When downloading software updates, a Progress bar is now shown (ALL)

 Updated default settings for Edit string option (MOS, MOT)

 Edit String point marker is now larger (MOS)

 Spreadsheet entry now supports 64 characters for point name when saving back to survey (ALL)

 Properties button is now disabled when no selection is made (ALL)

 Selection option introduced to Data Clean Up routine (MOS, MOT)

 Model> Data Clean up remembers previous settings (MOS, MOT)

 Rename Enquire to Inquire in Customize Toolbar (ALL)

 Improve Design> Roads> Alignment text prefixes (MOS, MOT )

 Revised Enterprise login to show password message (ALL)

 Improved lot annotation after a regen (MOS, MOT)

 The Enterprise login entered now populates the Change Password window (ALL)

 MO can now export non tangent road curves to MField (ALL)

 Added requirement that pad names needs to be unique (MOS, MOT)

 Renamed View> Google Earth (ALL)

 Linestyle hatching now applies edge thickness in Polygons (ALL)

 Rename CE Device to "Mobile device" in Sync Utility (ALL)

 Added Save/Load for Program settings (ALL)

 Unit Settings Format Station to determine Station or Chainage terminology. Applies to program
dialogs, reports, plotting (MOS, MOT)

 Pin to taskbar from running MO pointing to ccMain adressed (removed ccMain.exe) (ALL)

 Revised issue with create DTM with trim boundary (MOS, MOT)

 Added Rename and relocation options under Modify ribbon (ALL)

 Transfer roads from MTools to MO now transfers batter slopes values (MOS, MOT)

 Removed message appearing twice during Merge DTM option (MOS, MOT)

 Elevate from contours now allows selection of text label and contour string (MOS, MOT)

 Remove duplicate messages in some options (ALL)
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 Removed Project/Program settings> Unit setting> Display> Elevation flag and force ON (ALL)

Interpolate Z will interpolate where current DTM is applicable

 Project Unit settings coordinate order (NE) to set default order in spreadsheet entry (ALL)

 Message displayed to restart MO after upgrading licence (MOS, MOT)

 Renamed Contour Settings to Contour Styles (MOS, MOT)

Removed Settings > Settings > Contour 

 Made "Auto Set Interval" base on DTM's highest and lowest levels instead of using m in and max
levels in contour settings (MOS, MOT)

 Prompt for point properties no longer updated after changing elevation settings during Insert point
related commands (ALL)

 Lines without points can now be used with Modify> move, copy, rotate, scale, align options (ALL)

 Revised issue importing TP3 with invalid triangles (ALL)

 Segment line prompt bar re-aligned (ALL)

 Bylayer point mark setting revised (ALL)

 Enabled ability to rename project codes layer name (ALL)

 Prevent text layer change in linestyle editor

 Include TEXT when exporting Magnet Field Job file (ALL)

 Image view dialog size issue addressed (ALL)

 Renamed Inquiry> Set Out to Stakeout (ALL)

 Checkbox setting in Enterprise Chat addressed (ALL)

 Modify> Extend/Trim to Boundary with string no longer converts string to a line if only one segment
(MOS, MOT)

 Revised trimming a string with multiple points (ALL)

 Enterprise Chats sent from other user no longer displays {Empty Chat} (ALL)

 Removed duplicate point in Inert polyline/string, and data c leanup when polyline/string is closed
(MOS, MOT)

 Dialog adjustment and resizing for language translation (ALL)

 Polygon in inactive layer revised when moved (ALL)

 Revised for specific DWG file import (ALL)

 Revised TP3 import when missing last road segment (ALL)

 Improve MF to MO data for ByLayer points (ALL)
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 BOM is added for exported unicode XML (for MAGNET Field) (ALL)

 Import txt file improved when xyz file imported with no height (ALL)

 Surface> Quick Volumes no longer removing reference DTM (MOS, MOT)

 Quick volume dialog setting retained (MOS, MOT)

 Adjusted large polygons not showing correct area in property dialog if mean elevation is non-zero
(ALL)

 Display message when deleting layer (ALL)

 Enhanced display for offset distance with strings (ALL)

 Setting xsect interval to zero when importing 3DMC now displays message (ALL)

 Revised coordinate conversion for jobs saved from Drawing (Inches), when unit is set to FEET (ALL)

 Input bar now reset with segment circle (ALL)

 String now recognised as selection in recreate annotation (ALL)

 Revise Select by Region routine (MOS, MOT) 

 Revise Extend/Trim to Boundary routine (MOS, MOT)
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MAGNET Office Tools

General

 Support Beidou (BDS), Galileo and QZSS raw data for import/export and post-processing

 Support Civil 3D 2014 and Civil 3D 2015 dwg format

 Advanced Imaging Module
o Import embedded FSN Files together with the MJF
o Import Field Orientation Data (foe, fos)
o Import Field Scan Data (fsc)
o Import Photo Fieldbook (fsn)

Coordinate Systems

 Added support for the Luxemburg datum transformation

 Localization dialog is now allowed to create a new point and enter coordinates

 Enhanced support for datum parameters from WGS84 to Local

 Added support for the new Spain geoid (EGM08-REDNAP)

 Added support for Slovak Republic transformation (JTSK03-JSTK)

Reports

 Added the Prism constant to TS Observation report

 Added a Context Report for Stakeout Reports

 Enhanced Localization report to include Maximum of localization residuals report

 Enhanced Resection report includes standard deviations for calculated resection points

Import/Export



93

© 2011-2016 Topcon Positioning Systems, Inc.,  All rights Reserved

 Enhanced data selection during export

 Enhanced export support:
 StarNet
 Grontmij
 IOB Geolab

 Enhanced Import Support
o Neutral Files
o Coordinates from CSRS-PPP Engine
o Code Library from custom text files
o Support fixed width text fields for custom formats

Enterprise

General

 Added support for Enterprise in Civil 3D Ribbon

 Added support to exporting projects to Enterprise and MJF or TP3

 Added 'Forgot Password' option to Enterprise login dialog

Project Manager 

 Added support for Redlines generated in Enterprise

 Added support for Timecards created in Enterprise

 Added support for Tasks created in Enterprise

Miscellaneous

 Added new 3D view

 Added new Startup Wizard

 Enhanced Job Properties dialog includes information about objects

 Added support for named linework

 Enhanced functions for Rotate and translate points
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 Added support for Field Reports

 Added support for Avoidance Areas

 Prism constant in Total Station measurements is now editable

 Added a command to ignore vertical measurements on backsights

 Added support for Bing Maps in the Observation View

 Enhanced support in the Raw Data plot for color selection

 Users can now copy data from Residual View to the clipboard

 Added support for Station Equations

 Added a Start Station c olumn in Horizontal Elements

Exchange

Topcon Exchange for AutoCAD

 Added support for Enterprise Chat, Download and Upload from Civil 3D

 Users can now Export drawings to: MJF, TP3, PT3, LN3, TN3 and, MJT
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Known Issues

MAGNET Field and Office 

MAGNET Field known issues:

 There is an issue with Deleted measured points prevents user from deleting a layer.  Even though all
entities have been deleted or removed from the layer, the deleted point will prevent the user from
deleting the layer. 

 When importing a ZIP-archive file into MAGNET Field that includes SHP-Files it is necessary to first place
all .shp-files in one directory and then archive the files.  If there are any folders within the archive,
MAGNET Field will not import the .shp.zip file.

 There is an issue in Stake Road where the Cut/Fill display value for the Catch Point is not shown correctly
when an offset value is entered.

 When staking a grid, the Normal and Overhead views are not available.  

 There is an issue where MAGNET Field may fail to automatically reconnect to the DS-200Ai when using a
WT-100 and the connection is lost.  

MAGNET Office known issues:

 MAGNET Office may show 'unrecognized module(s)' under 'Activated Modules'.  The modules are
reserved for an upcoming release and do not affect current users. 

 Existing users who have not updated to MAGNET Offic e 3.0 and are running earlier version(s) of MAGNET
Office, will not be able to open V3.0 projects.  An option for Office users who choose not to update is to
export an XML file from Office V3.0 and import to the earlier version.  

 There is a known issue in MAGNET Office V3.0 when a projec t contains more than 30 drawings, users
may not be able to open the project in V3.0.  

 When using Winword as the external editor, a unic ode message may be displayed when Winword is
opened.  Press OK to continue.
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